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Abstract

These Application Notes describe the steps for configuring Avaya IP Office Release 11.1 with
the AT&T IP Transfer Connect service using AVPN or ADI/PNT transport connections.

The AT&T IP Transfer Connect service is a service option available with the AT&T IP Toll
Free service, and supports the rerouting of inbound toll free calls to alternate destinations based
upon SIP redirection messages from Avaya IP Office Release.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Note that these Application Notes are intended to supplement the separate document:
Application Notes for Avaya IP Office Release 11.1 with the AT&T IP Toll Free Service — Issue
1.0.

AT&T is a member of the Avaya DevConnect Service Provider program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps for configuring Avaya IP Office Release 11.1 with
the AT&T IP Transfer Connect service using AT&T Virtual Private Network (AVPN) or AT&T
Dedicated Internet Service ADI/PNT transport connections®.

Avaya IP Office is a versatile communications solution that combines the reliability and ease of
a traditional telephony system with the applications and advantages of an IP telephony solution.
This converged communications solution can help businesses reduce costs, increase productivity,
and improve customer service.

AT&T IP Transfer Connect is a service option available with the AT&T IP Toll Free service,
and supports the rerouting of inbound toll free calls to alternate? destinations based upon SIP
redirection messages from Avaya IP Office.

Note — These Application Notes are intended to supplement the separate document: Application
Notes for Avaya IP Office Release 11.1 with the AT&T IP Toll Free Service — Issue 1.0. This
document is listed in Section 9 as reference document [7]. It is recommended that this AT&T IP
Toll Free service document should be available as a reference during provisioning to the AT&T
IP Transfer Connect service.

Note — The AT&T IP Transfer Connect service is referred to in the remainder of the document as
IPTC.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

The interoperability compliance testing focused on verifying inbound call flows between IPTC
and the Customer Premises Equipment (CPE) containing the Avaya IP Office Release 11.1 (see
Section 3.2 for call flow examples).

L ADI/PNT transport does not support compressed RTP (cRTP), however AVPN transport does support cRTP
2 Note that this is NOT the same as the “Alternate Destination Routing (ADR)” service option available with the
AT&T IP Toll Free service.
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The test environment described in these Application Notes consisted of:
e A simulated enterprise with Avaya IP Office 11.1; Voicemail Pro; Avaya SIP, H.323,
Digital and Analog telephones.
e Laboratory versions of the IPTC service, to which the simulated enterprise was connected
via AVPN transport.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between Avaya systems and
the IPTC service did not include use of any specific encryption features as requested by AT&T.
Encryption (TLS/SRTP) was used internal to the enterprise between Avaya products wherever

possible.

2.1. Interoperability Compliance Testing

The compliance testing was based on a test plan provided by AT&T, for the functionality

required for certification as a solution supported on the IPTC network. Calls were made from the
PSTN across the IPTC test network, to the CPE. The interoperability compliance testing focused
on verifying inbound call flows (see Section 3.2) between Avaya IP Office and the IPTC service.

The following SIP trunking VolP features were tested with the IPTC service:

e Inbound IPTC calls to Avaya IP Office SIP (1140E, J169 and Avaya IX™ Workplace for
Windows softphone), H.323 (9608) and Digital (9508) telephones; utilizing G.729A
codec (IPTC preferred codec).

e Inbound IPTC calls that are immediately redirected by a SIP 302 message, generated by
Avaya IP Office, back to the IPTC service for redirection to an alternate destination (pre-
answer redirection).

e Inbound IPTC calls that are redirected by a SIP REFER (without Replaces) message,
generated by Avaya IP Office/\Voicemail Pro, back to the IPTC service for redirection to
an alternate destination. However, in this case an announcement is played to the caller by
Avaya IP Office/Voicemail Pro, prior to the redirection (post-answer redirection).

e Recovery from unsuccessful post-answer redirection attempts due to busy or error
conditions on the alternate destination.

e Verify reception of IPTC SIP Multipart/NSS headers, including SDP and XML content.

e Auvaya IP Office features such as hold, resume, and local transfer.

e SIP OPTIONS messages used to monitor the health of the SIP trunks between the CPE
and AT&T.
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2.2. Test Results
The test objectives stated in Section 2.1, with limitations as noted below, were verified.

1. Avaya IP Office only supports a packet size (ptime) of 20 msecs. Although no issues
were found during testing, AT&T recommends that for maximum customer bandwidth
utilization, a ptime value of 30 msecs should be specified.

2. Avaya IP Office does not support transmission of User-to-User (UUI) data. The
IPTC service allows for the optional inclusion of UUI data in both 302 and REFER SIP
messages. However, Avaya IP Office/\VVoicemail Pro does not currently support
transmission of UUI data over 302 or REFER messages.

3. Enhanced CID — NSS feature. The inbound calls to Avaya IP Office are not exercising
the Enhanced CID feature. Although Avaya IP Office is accepting SIP Multipart/NSS
headers, it is neither passing nor acting upon it, this data is simply being ignored.

4. IPTC services IP InfoPack and Landline/Mobility test cases could not be executed.
The AT&T supplied IPTC test plan specifies test cases to verify the inbound transmission
of INFOPAK and Landline/Mobility data by the IPTC service. Due to network
provisioning and support issues, these test cases could not be executed.

2.3. Support

AT&T customers may obtain support for the AT&T IP Transfer Connect service by calling (800)
325-5555.

Avaya customers may obtain documentation and support for Avaya products by visiting:
http://support.avaya.com. In the United States, (866) GO-AVAY A (866-462-8292) provides
access to overall sales and service support menus. Customers may also use specific numbers
(provided on http://support.avaya.com) to directly access specific support and consultation
services based upon their Avaya support agreements.
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3. Reference Configuration

The reference configuration used in these Application Notes is shown in Figure 1 on the next
page and consists of the following components:

Avaya IP Office provides the voice communications services for a particular enterprise site.
In the reference configuration, Avaya IP Office runs on the Avaya IP Office Server Edition
platform. Note that this solution is extensible to deployments using the standalone IP500 V2
platform as well.
In the sample configuration, the Primary server runs the Avaya IP Office Server Edition
Linux software. Avaya Voicemail Pro, running as a service on the Primary Server, provided
the “Modules” required to generate the REFER (without Replaces) SIP messaging (see
Section 5.3).
The Expansion System (V2) is used for the support of digital, analog and additional IP
stations. It consists of an Avaya IP Office 500v2 with analog and digital extension expansion
modules, as well as a VCM64 (Voice Compression Module).
Avaya endpoints are represented with Avaya 9608 H.323 deskphones, Avaya 9508 Digital
deskphones, Avaya J169 and 1140E SIP deskphones, as well as Avaya IX™ Workplace for
Windows (SIP) softphones.
In the reference configuration, Avaya IP Office interface “LAN1” is connected to the private
CPE, and interface “LAN2” is connected to the public network and AT&T.
The AT&T IPTC service requires the following SIP trunk network settings between the
Avaya IP Office LAN2 interface and the IPTC Border Element:

o UDP transport using port 5060

o RTP port ranges 16384-32767
AT&T provided the inbound access numbers (DID and DNIS) used in the reference
configuration. Note that the IPTC service may deliver various digit lengths in the SIP Invite
R-URI depending on the circuit order provisioning. In the reference configuration, the IPTC
service delivered 10 digits.
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Figure 1: Reference Configuration
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3.1. lllustrative Configuration Information

The specific values listed in Table 1 below and in subsequent sections are used in the reference
configuration described in these Application Notes, and are for illustrative purposes only.
Customers must obtain and use the values based on their own specific configurations.

Note — The Avaya IP Office LANZ interface communicates with the AT&T Border Element
(BE) located in the AT&T IPTC network. For security reasons, the IP addresses of the IP Office
LAN2 interface and the AT&T BE is not included in this document. However, as placeholders in
the following configuration sections, the IP addresses 192.168.80.43 (Avaya IP Office LAN2
address), and 192.168.225.210 (AT&T BE IP address), are specified. In addition, AT&T
DID/DNIS numbers shown in this document are examples as well. AT&T Customer Care will
provide the actual Border Element IP addresses and DID/DNIS numbers as part of the IPTC
provisioning process.

Component Illustrative Value in these
Application Notes

Avaya IP Office
Primary Server LAN1 interface 10.64.19.170
Primary Server LANZ2 interface 192.168.80.43
Expansion System, LAN1 Interface 10.5.5.180
AT&T IPTC Service
Border Element IP Address | 192.168.225.210

Table 1: Hlustrative Values Used in these Application Notes
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3.2. Call Flows

To understand how inbound AT&T IPTC service calls are handled by Avaya IP Office, three
basic call flows are described in this section.

3.2.1. Basic Inbound Call

The first call scenario illustrated in Figure 2 is an inbound IPTC service call that arrives at
Avaya IP Office, and is subsequently routed to an endpoint. Note that no call redirection is
performed in this scenario.

1. A PSTN phone originates a call via the IPTC service.
2. The PSTN routes the call to the IPTC service network.
3. The IPTC service routes the call to Avaya IP Office.
4. Depending on the called number, Avaya IP Office routes the call to the associated
endpoint.
AT&T
—1 IP Transfer Connect
@ Service
PSTN
Phone1
Avaya
IP Office
:
R
Phone
Figure 2: Inbound IPTC Call — No Redirection
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3.2.2. 302 Call Redirection

Note: In the call scenarios that follow, the term “alternate destination” does NOT refer to the
“Alternate Destination Routing (ADR)” service option of the AT&T IP Toll Free service. ADR
and the IPTC service are unrelated.

The second call scenario illustrated in Figure 3 is an inbound IPTC service call that arrives at
Avaya IP Office, which in turn generates the 302 SIP message.
1. Same as the first three steps from the call scenario illustrated in Section 3.2.1.
2. Avaya IP Office redirects the call by sending a SIP 302 message back out the SIP trunk
(see Section 5.2.1). The SIP 302 message is routed back to the IPTC network. Avaya IP
Office releases the trunk.
3. The IPTC service places a call to the alternate destination and upon answer, connects the
calling party to the target party (alternate destination).

Note that no audio is transmitted between Avaya IP Office and the PSTN caller during the 302

transaction.
Alternate
39| Destination |q3p

AT&T
IP Transfer Connect
Service

1 1
-3 3

PSTN Phone
Phone1
1 2
vy |
Avaya
IP Office
Figure 3: Inbound IPTC Call — SIP 302 Redirection
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3.2.3. Refer Call Redirection

The third call scenario illustrated in Figure 4 is an inbound IPTC service call that is routed to

Avaya IP Office, which routes the call to VVoicemail Pro. A predefined VVoicemail Pro Module

redirects the call back to the IPTC service using a Refer?, for routing to an alternate destination.
1. Same as the first step from the call scenario illustrated in Section 3.2.2.

2. Avaya IP Office routes the call to Voicemail Pro.

3. Voicemail Pro executes a corresponding Module (see Section 5.3), which plays an
announcement back to the PSTN caller, stating that the call is being redirected.

4. Voicemail Pro redirects the call by sending a SIP Refer (without Replaces) message back
out on the SIP trunk. The SIP Refer message is sent to the IPTC service network. Avaya
IP Office releases the trunk. The IPTC service places a call to the alternate destination
and upon answer, connects the calling party to the target party (alternate destination).

1 Alternate
< Destination |49
PSTN =4-» Agent /Phone
Phone1
: : L Avaya
Voicemail Pro 3 _
i IP Office
Figure 4: Inbound IPTC Call —-SIP REFER Redirection
3 This is a Refer without the Replaces parameter (i.e., a “Blind Refer”).
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4. Equipment and Software Validated

The following equipment and software were used for the reference configuration described in
these Application Notes.

Equipment/Software | Release/Version
Avaya

Avaya IP Office Server Edition Release 11.1.0.0.0 Build 237

- Avaya IP Office Voicemail Pro Release 11.1.0.0.0 Build 234
Avaya IP Office 500 V2 Expansion System Release 11.1.0.0.0 Build 237
Avaya IP Office Manager Release 11.1.0.0.0 Build 237
Avaya 96x1 Series IP Deskphone (H.323) Release 6.8304
Avaya 1140E IP Deskphone (SIP) Release 04.04.23.00
Avaya J169 IP Deskphone (SIP) Release 4.0.6.0.7
Avaya [IX™ Workplace Client for Windows Release 3.9.0.84.8
Avaya 9508 Digital Deskphone Release 0.60

Table 2: Equipment and Software Versions

Note — Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500 V2, and also when deployed with all configurations of IP Office Server Edition. IP
Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital
endpoints or trunks.
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5. Avaya IP Office Configuration

Note — Avaya IP Office administration for interaction with the AT&T IP Toll Free service is
described in document [7] and is applicable for the IPTC service as well (see the note in

Section 1). This section describes the additional administration steps on Avaya IP Office
necessary for supporting interaction with the IPTC service. It is recommended that the AT&T IP
Toll Free service document should be available as a reference during provisioning to the AT&T
IP Transfer Connect service.

IP Office is configured via the IP Office Manager program. For more information on IP Office
Manager, consult reference Error! Reference source not found.. From the IP Office Manager PC,
select Start = All Apps = IP Office 2 Manager to launch the Manager application. Navigate
to File = Open Configuration (not shown), select the proper Avaya IP Office system from the
pop-up window, and log in using the appropriate credentials.

=

Name IP Address  Type Version Edition
Server Edition 11.1
IPOSE-Primary 10.64.18.170  IPO-Linux-PC  11.1.0.0.0 build 237  Server (Primary) Select

Configuration Service User Login

IP Office: IPOSE-Primary (Primary System - IPO-Linux-PC)

Service User Name |Adm|n|stratnr ‘

Service User Password | ----------- | ‘

TCP Discovery Progress

Unit/Broadcast Address

10.64.19.170 ~ Refresh Cancel

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side, the Group pane in the center, and the Details pane on the right side.
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5.1. SIP Line

The following sections describe the configuration of a SIP Line. The SIP Line terminates the
CPE end of the IP Office SIP trunk to the AT&T IPTC service.

The recommended method for creating/configuring a SIP Line is to use the template associated
with the provisioning described in these Application Notes. The template is an .xml file that can
be used by Avaya IP Office Manager to create a new SIP Line for SIP trunking with the AT&T
IPTC service.

Follow the steps in Sections 5.4.1 of document [7] to import/create a SIP Trunk from the
template.

Note - In document [7], SIP Line 16 was created for use with the AT&T IP Toll Free service.
SIP Line 16 was used for the IPTC testing as well, and is referenced in the following sections.

5.1.1. SIP Line — SIP Line tab
The SIP Line tab is shown below for the existing Line Number 16 (see the note above). This
SIP Line form is modified as follows for the IPTC service:

e Check the box next to Send 302 Moved Temporarily.

e Check the box next to Outgoing Blind Refer.

e Click on OK.
= SIP Line - Line 16 ef - X vi<]>
SIP Line Transport Call Details VolP  SIP Credentials SIP Advanced Engineering

Line Number 16 = In Service

ITSP Domain Name | | Checkoos

Local Domain Name |192.163.SD.43 |

URI Type SIP URI ~|  Session Timers

Location Cloud o Refresh Method Re-invite ~
Timer (sec) 1800 =

Prefix | |

National Prefix o |

International Prefix |DD |

Country Code | | Redirect and Transfer

Name Priority System Default - Incoming Supervised REFER Auto ~

Description |AT&T IPTF | Outgeing Supervised REFER Auto ~
Send 302 Moved Temporarily
Outgeoing Blind REFER
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5.1.2. SIP Line — SIP Advanced Tab
Navigate to SIP Line - SIP Advanced tab.

e Verify that the Emulate NOTIFY for REFER is not checked.

e Click on OK.

Addressing

Association Method

Call Routing Method

Use P-Called-Party

Suppress DNS SRV Lockups

Identity

Use "phone-context”

Add user=phone

Use + for International

Use PAI for Privacy

Use Domain for PAI
Caller ID from From header
Send From In Clear

Cache Auth Credentials

Send Location Info

Add UUI header

Add UUI header to redirected
calls

SIP Line Transport Call Details VolP

User-Agent and Server Headers

SIP Credentials SIP Advanced Engineering

By Source IP address

Request URI

HIDDDDDDD o O

Mever

Media

Allow Empty INVITE
Send Empty re-INVITE
Allow To Tag Change

P-Early-Media Support
Send SilenceSupp=0ff

Media Connection
Preservation

Indicate HOLD

Call Control

Call Initiation Timeout (s)
Call Queuing Timeout (mins)
Service Busy Response

on Mo User Responding Send

Action on CAC Location Limit

Suppress (1.850 Reason
Header

Disabled ~

4 -

3 =
486 - Busy Here ~
480-Ternporarily Unavailable ~

Allow Voicemail ~

|

Emulate NOTIFY for REFER

0|

Mo REFER if using Diversion

O
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5.2. Incoming Call Routes to Trigger 302 or Refer Call Redirection

Two call redirection methods are supported by the IPTC service; SIP 302 and Refer (without
Replaces). While both of these methods utilize the Avaya IP Office Incoming Call Route table,
the Destinations specified for each are different. The 302 redirection is triggered by Avaya IP
Office, while the Refer redirection is triggered by a Module defined in VVoicemail Pro.

Note — In the reference configuration the IPTC service provided the access number 11041 for
use in the 302 and Refer testing.

Note — Although the IPTC is an inbound only service, an outbound Avaya IP Office Short
Code must be defined to trigger the 302 and Refer Call Redirections. See Section 5.4.

5.2.1. 302 Call Redirection

In the example below, the incoming number 0000031043 is directed to trigger the 302 Call
Redirection.

1. From the Incoming Call Route page, select the Standard tab and enter the following:

e Line Group ID: Enter the SIP Line previously defined in Section 5.4 of document [7]

(e.g., 16).

e Incoming Number: Enter the associated DNIS digits sent by AT&T (e.g., 0000031043).
e Use default values for the remaining fields.

Configuration |

16 0000031043

=& BOOTP (4)

+-{7% Operator (3)

;-"’-3- Solution
+-§ User(31)

+ﬂ Group (4)
-8 Short Code (12)
4B Service (0)

£/ -1 Incoming Call Route (109)
=1l IP Route (2)

W License (11)

Standard  Voice Recording Destinations

Hold Music Source

Ring Tone Override

+ﬂ Group(s) Bearer Capability Any Voice
+1-@% Short Code(52) Line Group ID [16 ~|
+-#& Directory(2)
£ Time Profile(0) Incoming Mumber |DDUDD31D43 |
+- Account Code(1)
+§| User Rights(1) Incoming Sub Address | |
+E Location(7) Incoming CLI | |
=1 IPOSE-Primary 9
-5 Systern (1) Locale v
+-T9 Line (14)
+ = Control Unit (8) Priority 1-Low ~
+-4 Extension (18)
g User (21) Tag | |

System Source

|N0ne
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2. Select the Destinations tab and enter the following:
e Enter the string 711041 to the drop down menu, and click OK (not shown).

In this example, 7 is the outbound dialing Short Code (see Section 5.4), and 11041 is the IPTC
defined access number to be used for the call redirection.

i= 16 0000031043 i Xiwvl < >
Standard Voice Recording Destinations

TimeProfile Destination Fallback Extension
3 Default Value 71104 w w

When the 0000031043 number is received in an Invite, Avaya IP Office will generate a 302
message, with 11041 in the Contact header, back to the IPTC service. The IPTC service will then
generate a new Invite to the destination associated to access code 11041.

5.2.2. Refer Call Redirection

In the reference configuration, Voicemail Pro (running on Primary server), is used to send a
Refer (without Replaces) Call Redirection. A Voicemail Pro “Module” is defined with the name
Refer (see Section 5.3). This Module name is defined as a Destination to an inbound call as
follows:
1. From the Incoming Call Route page, select the Standard tab enter the following:
e Line Group ID: Enter the SIP Line previously defined in Section 5.4 of document [7]
(e.g., 16).
e Incoming Number: Enter the associated DNIS digits sent by AT&T (e.g., 0000021042).
o Use default values for the remaining fields.

Configuration |EE 16 0000021042
+’$ BOOTP {4) Standard Vpice Recording  Destinations
+-4# Operator (3)
= - Eolution
£ User(31) i - -
+ﬂ Group(3) Bearer Capability Any Voice
£-9X Short Code(62) Line Group ID |15 v|
+--2m Directory(2)
Time Profile(0) Incoming Number |DCIDDCIE1 042 |
t Account Code(1)
+§ 1 User Rights(1) Incoming Sub Address | |
+i$ Location(7) .
=% IPOSE-Primary Incoming CLI | |
+h‘_ S}rstem (n Locale o
+-T9 Line (14)
-2 Control Unit (8] Priority 7=y v
+-4 Extension (18)
#-§ User @1) Tag | |
5@ Group (4)
+- 8% Short Code (12) Hold Music Source System Source ~
i Service (0]
+% Ring Tone Override |N0r‘|e v|
-l 1P Reute (2)
i License (11)
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2. Select the Destinations tab and enter the following:

¢ In the Destinations column, enter the string VM:ATT _IPTC to the drop down menu,
and click OK (not shown).

In this example, VM: specifies that the destination is a Module on VVoicemail Pro, and
ATT _IPTC is the name of the Module (see Section 5.3).

i= 16 0000021042 [ Xl v < >
Standard Voice Recording Destinations

TimeProfile Destination Fallback Extension
» Default Value VNGATT_IPTC ~ ~

When the 0000021042 number is received in an Invite, Avaya IP Office/\VVoicemail Pro will play
and announcement to the caller, then generate a Refer (without Replaces) message, (with 11041
in the Refer-To header), back to the IPTC service. The IPTC service will then generate a new
Invite to the destination associated to access code 11041.

5.3. Voicemail Pro Refer Module

Note - While Avaya Voicemail Pro provisioning and programming is beyond the scope of this
document, a sample Module is described below.

The Refer Module is provisioned to play an announcement to the caller, and then generate a
Refer (without Replaces) back to the IPTC service. This is accomplished via the following steps
via the Voicemail Pro Client interface:

1. Open the Voicemail Pro Client application (not shown).
2. Create a Start Point by right clicking on Modules and selecting Add.

t] Voicemail Pro Client (Intuity) - Connecteq

File Edit Actions Administration

& (j IPOSE-Primary (10.64.19.170)
O Voicemail Pro Administrators
4] tj Server Queues
72 Distributed Voicemails
) Eventing Notfications
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3. Enter aname (e.g., ATT_IPTC) and click on OK (not shown). The new script
“ATT _IPTC” will appear under Modules and a Start Point icon will appear in the work

area.
E Voicemail Pro Client (Intuity) - Connected to 10.64.19.170 (Select Mode)
File Edit Actions Administration Help
A& 4d DB 20 W SA¥ /&3 &8 ae-
53] d IPOSE-Primary (10.64.15.170) Modules > ATT_IPTC
d Voicemail Pro Administrators
@ tj Server Queues
v Distributed Voicemails P Start Paint
tj Eventing Notifications Next
=] E' Modules
o8 ATT MM
.88 ATTIPTC
=52 ATT IPTF

'>- Start Point
e Click on the Start Point icon M to activate the script options at the top of the

screen. From the options, Telephony Actions |conﬁ select the Transfer icon % and

click on the work area to place the Transfer icon in the work area.

i’.ﬂfﬁl%‘ﬂ‘lﬁ}

Modulen > ATT_IPTC Warisble Roubing
Fagine nDgimes Call
[ Siwt Pt | Feute by Call St
[Hest Trarcher
hripei

Calilint

Dl by Movat

Asinbed Taaraler

BFEE S e

Alphsregmans Colaction

WA S G EB e 8

Modules > ATT_IPTC

J=- Start Faint
Mext - .
lﬁ- Transfer E
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4. Double click on the Transfer icon. On the General tab = Token Name field, enter
Refer (not shown).

5. Select the Entry Prompts tab and select or create an announcement to be played to the
caller prior to the Refer (e.g., refer.wav). To modify an existing recording, double click

on the .wav file and rerecord. If no .wav files exist, double click on the RE icon to open
the .wav file editor.

Properties for Refer

General Entry Prompts  Specfic  Reporting  Results

4 X L4
Order Prompt Length (g}
1 refer wav 25 (Remote)

<

[ Mllow prompts to be intemupted by Tones

Cancel Help

6. On the Specific tab enter 711041, where 7 is the Avaya IP Office outbound Short Code,
and 11041 is the redirection number specified by the IPTC service (see Section 5.2.2).

7. Click on OK.

MAA; Reviewed:
SPOC 9/9/2020

Properties for Refer
General Entry Prompts  Specific  Feporting  Results
Transfer call to

Destination
[F11041 | =

Source of transfer (displayed on phone)

Description (displayed on phone)

[ Set Caller Priority
Low

[] Notify Caller of Transferto Target

Cancel Fe
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8. From the options bar, select the Connector icon <" and drag a connecting flow line
from the Start Point box to the Transfer box.

.’.l\j
File Edit Actions Administration Help
A& LDB L% 4 DAR S QI LB P A6
- [:I IPOSE-Primary (10.64.19.170) Modules > ATT_IPTC
; [j Voicemail Pro Administrators
+ tj Server Queues
v Distributed Voicemails [ Start Paint
: [j Eventing Notifications Next
7 Refer

= E‘ Modules

=2 ATT_AA

= ATT_IPTC

=85 ATT IPTF

9. From the top menu select File > Save & Make Live, or select the & icon.

When the IPTC DNIS number is received (e.g., 0000021042), IP Office sends the call to
Voicemail Pro (see Section 5.2.2). The caller will hear an announcement (e.g., refer.wav), and
Voicemail Pro/Avaya IP Office sends a Refer back to the IPTC service, specifying 11041 in the
Refer-To header. The IPTC service will then send a new Invite to the destination associated to
access code 11041.

5.4. Outbound Short Code for 302 and Refer Call Redirection

Avaya IP Office provides predefined Short Codes, however new Short Codes may be defined to
match number strings to an action. To add a Short Code, right click on Short Code in the
Navigation pane, and select New (not shown). To edit an existing Short Code, click Short Code
in the Navigation pane, and the Short Code to be configured in the Group pane.

Note — Although the IPTC is an inbound only service, an outbound Short Code must be
defined to trigger the 302 and Refer Call Redirections.

In the following screen, the Short Code 7N; is illustrated (note the semicolon at the end of the
string). This Short Code will allow Avaya IP Office to generate a 302 or Refer message back to
the IPTC service (see Sections 5.2 and 5.3).

1. Right click on Short Codes from the left hand menu and select New (not shown).
e The Code parameter is set to 7N; (note that 7 was used in the reference configuration,
however any available number string may be used).
e The Feature parameter is set to Dial.
e The Telephone Number parameter is set to N.
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e The Line Group ID parameter is set to the SIP Line previously defined in Section 5.4 of
document [7] (e.g., 16).
e Click the OK button (not shown).

—

= 7N;: Dial

Short Code
Code ™ |
Feature Dial ~
Telephone Mumber |I"-J |
Line Group ID |16 v]
Locale ~
Force Account Code O
Force Authorization Code []

5.5. Saving Configuration Changes to Avaya IP Office

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP
Office server in order for the changes to take effect. At the top of the Avaya IP Office Manager
page, click File = Save Configuration (if that option is grayed out, no changes are pending).

A screen similar to the one below will appear, with either Merge or Reboot automatically
selected, based on the nature of the configuration changes. The Merge option will save the
configuration change with no impact to the current system operation. The Reboot option will
save the configuration and cause the Avaya IP Office server to reboot. Click OK to execute the
save.

%7 Send Multiple Configurations - [m} >
Select " Change Incoming Outgoing Error
P Office Mode RebootTime Call Barring Call Barring Status Progress
» IPOSE-Primary | Merge | 10:02 AM O O Q =
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6. AT&T IP Transfer Connect service Configuration

AT&T provides the IPTC service border element IP address, the access DID numbers, and the
associated DNIS digits used in the reference configuration. In addition, the AT&T IPTC features,
and their associated access numbers, are also assigned by AT&T. AT&T requires that the Avaya
IP Office public (LAN2) IP address be provided to the IPTC service, as part of the provisioning
process.

7. Verification Steps

The following procedures may be used to verify Avaya IP Office Release 11.1 with the AT&T
IP Transfer Connect service configuration.

7.1. Call Verification Tests

The call verification steps and troubleshooting tools described for the AT&T Toll Free service
described in document [7], also apply to the IPTC service. However additional verification steps
specific to the IPTC service are described below.

1. Place an inbound call to an IPTC service line enabled with Redirect features. Verify that
Avaya IP Office redirects the call back to the IPTC service for redirection to an alternate
destination using 302. Verify that the 302 message contains the redirection number in the
Contact header. Verify two-way talk path and transmission between the caller and the
redirected destination.

2. Place an inbound call to an IPTC service line enabled with Refer features. Verify that
Avaya IP Office directs the call to Voicemail Pro, which then redirects the call back to
the IPTC service using Refer (without Replaces) for redirection to an alternate
destination. Verify that the caller hears an announcement prior to the call redirection.
Verify that the Refer message contains the redirection number in the Refer-To header,
and that the Refer-To header does not contain a “Replaces” parameter. Verify two-way
talk path and transmission between the caller and the redirected destination.
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7.2. System Monitor Traces

Monitor the SIP traffic at the connection to the IPTC service, using IP Office System Monitor.
The System Monitor application can typically be accessed from Start > Programs - Avaya
IP Office > Monitor.

7.2.1. 302 Redirection

The following is an example of a 302 redirection.

The Contact header contains the new destination number (11041) as defined in the Avaya IP
Office Incoming Call Route Destination field (see Section 5.2.1). The IPTC service will then
generate a new Invite to the 11041 destination.

[®} Avaya IP Office SysMonitor - Monitoring 10.64.19.170 {IPOSE-Primary (Server Edition(P]) (Select)); Log Settings - C\Users\...\sysmenitorsettings.ini
File Edit View Filters Status Help

=8| »lElT| x[F @l

¥AAEAAANAS FysMonitor wll.1.0.0.0 build 237 [connected to 10.64.19.170 (IPOSE-Primary (3erver Edition(P)) (Select))] *¥d¥vdiray

960812203m5 Sip: S5IPDialog::ExtractResponseParamsFromViaHeader remote sent_by: 192.168.225.210:5080 trunk

9€0812203mS Sip: S5IPDialog::ExtractResponseParamsFromViaHeader remote sent by transport: SIB/2.0/UDP trunk

960812203m5 Sip: SIFTrunkEndpointDialogOwner::SetRemoteAddressForResponse from 192.168.225.210:5080 to 192.168.225.210:5080
9€0812203m5S Sip: 024013aa000007%9 1€.1945.1 271 SIFTrunk Endpoint(f42€aell) SendSIPResponse: INVITE code 302 SENT TO 192.162.225.210 5060
960812204mS SIP Tx: UDP 192.165.80.43:5060 -> 192.165.225.210:5060

[ 5TE/2.0 302 Moved Temporarily |

Via: SIB/2.0/UDP 192.163.225.210:5060;branch=z5hG64bKaps5£82070npgkskr5£0.1

From: <sip:7963310799@152.168.225.210>;tag=052511652361052374_c2b08.2.4.1590567644296.0_37_97

Call-ID: 145356336921474@c2b03_2_4

CSeq: 2 INVITE

Contact: "11041" <s8ip:11041@192.168.225.210:5060; transport=udp>

Allow: INVIIE,RCK,CANCEL,OPTIONS,BYE, INFO, REFER, NOTIEY

Supported: timer

Server: IF Office 11.1.0.0.0 build 237

Content-Length: 0

To: <5ip:88845755819€192.168.680.43>;tag=£7218ad25d2ebb36

9€0812204mS Sip: 0a4013aa0000079%9 1€.1945.1 271 SIFTrunk Endpoint(f42€ael0) UpdateS5IPCallState SIFDialog::INVITE RCVD(9) -> SIPFDialog::INV_NON 200 FNL
960812204mS Sip: SIPFTrunkEndpoint::ProcessOutboundMsg->Redirection or BlindTransfer Success
9€0812265mS SIP Rx: UDPF 192.162.225.210:5060 -> 192.163.80.43:5060
ACK sip:0000031043@152.168.80.43:5060 SIB/2.0
Via: SIB/2.0/UDP 192.163.225.210:5060;branch=z5hG4bKaps5£82070npgkakr5£0.1
CSeq: 2 ACK
From: <3ip:7963310799@152.168.225.210>;tag=052511652361052374_c2b08.2.4.15%0567644296.0_37_97
To: <s8ip:88845752919@192.163.80.43>;tag=£7218ad25d2=bb36
Call-ID: 145356836921474@c2bk03_2 4
Max-Forwards: €6
Content-Length: 0

960812268m5 Sip: Find End Point2 0a4013aa000007%% 16.1945.1 271 SIPTrunk Endpoint (£45955d8) Sip Callld 145856936921474@c2b08_2_4
960812268mS Sip: 0a4013aa0000079% 16.1945.1 271 SIPTrunk Endpoint(£436ael0) Process SIP request dialog £436ael0, method ACK in state SIFDialog::INV_NO
960812268mS Sip: 0a4013aa0000079% 16.1945.1 271 SIPTrunk Endpoint(f426acl0) UpdateSIPCallState SIPDialog::INV_NON_200_FNL_SENT(13) -> 5IPDialcog::FINAL
9€0812367mS SIP Rxz UDP 192,162,225, 210:5060 —> 192, 162,80,43;:0080

| INVITE sip:0000011041@192.168.80.43:5060 SIE/2.0 |

Via: 5IB/2.0/UDF 192.163.225.210:5060;branch=z5hG4bEbh371h20a0416c3]led0.1

Privacy: none

P-Asserted-Identity: <sip:7863310799@192.168.225.210>

From: <sip:7863310795@152.168.225.210>;tag=75057369263580803_c2b05.2.4.1590567644296.0_38_101

To: <3ip:$884575519@€192.168.80.43>

Call-ID: 5783600547665316c2k03_2 4

Max-Forwards: €3

CSeq: 2 INVITE

Content-Type: application/sdp

Content-Length: 315

Contact: <s5ip:192.163.225.210:5060; transport=udp>

=0

o=5onus_UAC 2391 434 IN IP4 192.168.225.210
3=51IF Media Capabilities

c=IN IF4 192.163.225.210

=0 0

m=audic 16500 RTE/AVE 13 0 %8 100
a=rtpmap:13 G729/3000

a=fmtp: 18 annexb=noc

a=rtpmap:0 BCMU/2000

a=rtpmap:92 G726-32/8000
a=rtpmap:100 telephone-event/2000
a=fmtp:100 0-15

a=sendrecv

a=maxptime:30
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7.2.2. Refer Redirection

The following is an example of a Refer redirection.
e The Refer-To header contains the new destination number (11041) as defined in the
Voicemail Pro Refer Module (see Section 5.3). Also note that the Refer-To header does
not contain a “Replaces” parameter.

E} Avaya IP Office SysMonitor - Menitoring 10.64.18.170 (IPOSE-Primary (Server Edition(P)] (Select)); Log Settings - C:\Users\.. \sysmonitorsettings.ini -
File Edit View Filters Status Help

sla) (BT x[7 @l vlfim

kAkAkkkdk¥ Warning: Logging to Screen Started Y¥anAkdaak

Ahkadwaasy SysMonitor v11.1.0.0.0 build 237 [connected to 10.64.19.170 (IPOSE-Primary (Serwver Edition(P)) (Select))] *riariwnas

962189925mS Sip: 0a40132a000007a0 16.1952.1 273 SIPTrunk Endpoint(£48995d2) received CMFacility
962189925mS Sip: 0a4013aa000007a0 16.1852.1 273 SIPTrunk Endpoint(f486acl0) OnCmMessage - CMIESupplementaryService : CallTransferInitiate found, state is <SIPDi
962185525m3 Sip: 0a4013aa000007al 16.1552.1 273 SIPTrunk Endpoint(f4Z6aeld) GetHoldChangedFlag: owner->RequiresHoldStatus()=1, owner_ep->callinfo.ocutbound actiw
962189925mS Sip: 0a4013aa000007a0 1€.1952.1 273 SIPFTrunk Endpoint(£486ael0) REFER SENT TO 192.165.225.210 5080
962189925m3 SIP Tx: UDP 152.163.80.43:5060 -> 192.168.225.210:5060
[[REFER Sip:192.165.225.210:5060; transport=udp SIE/2.0 |

Wia: SIE/2.0/UDP 192.168.80.43:5060;rport;branch=z9nG4bEb%e5627047bcd472815c1lce91%e12596

From: <3ip:8384575819@192.165.80.43>:tag=676T31c4eéfadatle

To: <sip:79633107956192.168.225.210>; tag=7008752225795201_c3b07.2.4.1596562334901.0_7_23

Call-ID: 6705200751256322@c3b07_2_4

CSeq: 3 REFER

Contact: <sip:58545758196192.168.80.43:5060; transport=udp>

Max-Forwards: 70

Bllow: INVITE,ACK,CENCEL,CGPTIONS,BYE,INFO,REFER,NOTIFY

Supported: timer

User-Agent: IP Office 11.1.0.0.0 build 237

Content-Length: 0

Refer-To: <sSip:11041@192.168.225.210:5060; transport=udp>

962189926mS Sip: SIPTrunkEndpoint::ProcessOutboundMsg->Redirection or BlindTransfer Success
962190006m3 SIP Rx: UDP 152.168.225.210:5060 -> 192.1638.80.43:5080
SIP/2.0 202 ACCEFTED
Wia: SIP/2.0/UDP 192.1&%.80.43:5060;received=50.207.80.43;branch=z9hG4bKb9e5627047bcd472815c1c6919e12£96; rport=5060
From: <3ip:8384575819@192.165.80.43>:tag=676T31c4eéfadatle
To: <sip:7863310799@1%2.168.225.210>;tag=70038792225795201_c3b07.2.4.1596562334501.0_7_23
Call-ID: 6705200751256322@c3b07_2_4
CSeq: 3 REFER
Contact: <sip:19%2.168.225.210:5080; transport=udp>
Content-Length: 0

96219000€émS 5ip: Find End Point2 0a4013aa000007a0 16.1952.1 273 SIPTrunk Endpoint (£48995d3) Sip Callld &7
962190006mS Sip: 0a4013aa000007al 1€.1552.1 273 SIPTrunk Endpoint{f426aell) Process SIP response dialog £4
962190013mS SIP Rx: UDP 192.168.225.210:5060 -> 192.168.80.43:5080

NOTIFY 3ip:88845758190@192.168.80.43:5060; cransport=udp SIP/2.0

Wia: 5IB/2.0/UDP 152.1£%5.225.210:5060;branch=z5hG4bKgclgdg3ldgglsgdts3j0.1

Subscription-State: active;expires=119

Event: refer;id=3

From: <sip:7863310759@192.163.225.210>;tag="00587592225795201_c3b07.2.4.1596562334901.0_7_23

To: <sip:8834575819@192.168.80.43>;tag=876731cdebfadatfe

Call-ID: €70520075125632208c3b07_2_4

Max-Forwards: 68

CSeq: 4 NOTIFY

Content-Type: message/sipfragrversion=2.0

Content-Length: 20

Contact: <s5ip:192.168.225.210:5080; transport=udp>

0520075125632208c3b07_2_4
86ael0, method REFER, CodeNum 202 in state SIPDialog::

SIE/2.0 100 Trying
962190013mS Sip: Find End Point2 0a4013a2a000007a0 16.1952.1 273 SIFTrunk Endpoint (£48995d2) Sip Callld 6705200751256322@c3b07_2_4
962190013m3 Sip: 0a4013aa000007a0 16.1952.1 273 5IPTrunk Endpoint(f436aell) Process SIP request dialog f486ael0, method NOTIFY in state SIPDialog::CRLL_UP(16)
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8. Conclusion

As illustrated in these Application Notes, Avaya IP Office Release 11.1 can be configured to
interoperate successfully with the AT&T IP Transfer Connect service, within the limitations
described in Section 2.2.

The sample configuration shown in these Application Notes is representative of a basic
enterprise customer configuration and is intended to provide configuration guidance to
supplement other Avaya product documentation. It is based upon formal interoperability
compliance testing as part of the Avaya DevConnect Service Provider program.
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